BrioQuery™ Explorer

Version 6.x

Training Manual

Revised 8/2010
Part 1:

Introduction

In this chapter you will:

- Learn background information about the UM Data Warehouse.
- Observe a demonstration of Data Warehouse & BrioQuery.
- Overview the BrioQuery document, reports, features & tools.
- Know where to go for Help!
- Understand the format of this training manual & course.
What is the University of Maryland (UM) Data Warehouse?

The University of Maryland Data Warehouse is a collection of integrated institutional data that can be accessed by authorized UM business managers, administrators, service providers and institutional researchers for the purposes of performing analyses, producing ad hoc queries and reports and maintaining data subsets. Data are extracted from the campus business transactional systems, put into the data warehouse and retrieved and analyzed at the user’s desktop.

Data Warehouse Sponsorship

The UM Data Warehouse is a joint project among several units within the Office of Information Technology, Institutional Research, Planning & Assessment (IRPA), campus data stewards and managers (Human Resources, Payroll, Registrar’s Office, etc.) and end users of institutional data. All of these groups work in partnership to provide the hardware, software, training, support and data subsets.

Relationship of Warehouse to Transaction Systems

Data used by the UM Data Warehouse are extracted from transactional systems which handle the day-to-day operations of the university - collecting, processing and storing operational data. Examples of transactional systems are the Student Information System (SIS), the Academic Resource System (ARS) and the Payroll & Human Resources (PHR) system. Transaction systems handle processes such as registering a student, approving a faculty appointment or updating an email address in ARES. These transaction systems were not designed to provide managers with the information they need to conduct trend analysis, particularly when data are located on different platforms. Data warehouses, unlike transaction systems, are specifically designed to handle query capability and analyses. The UM Data Warehouse is also being used as the foundation for web-based data presentations, e.g. FRSWEB and ARES reports.

How the Warehouse is Built

To build the UM Data Warehouse, data were identified for inclusion (Broad range focus groups met to identify data needed), “cleaned” (checked for redundancy, data errors and conflicting definitions), and restructured (data naming standards applied and elements grouped for ease of querying). In addition, “derived” data were added. Derived data are newly created data elements that are computed from a combination of several existing data elements or by applying computational formulas. An example of a derived field is “age” which is derived from a person’s birth date. The process of identifying, cleaning, restructuring and deriving data is followed for every data subset (student, personnel, faculty, etc.) identified for inclusion in the data warehouse.

Once the data have been identified through the process noted above, programs extract the data from the transaction systems and put them into the data warehouse. Users can then
access data directly from the data warehouse and run canned and ad hoc queries as desired. Because they are extracted from transaction systems, data in the data warehouse are “view/read only” and cannot be updated. Any changes and/or corrections to the transactional data must be made in the actual transaction system and are reflected in the next refresh cycle.

**Data Refresh Cycles**

After data are initially loaded into the data warehouse, they must be refreshed on a periodic basis. Refreshing of a data subset is determined by a number of factors including static/non-static nature of data, need, etc. Some data subsets are refreshed several times a week and others may be refreshed once a term.

It is important to be aware of the refresh cycles when running a query. The “delay” between the actual transaction system and the data warehouse refresh cycle can affect the results obtained in a query. Refresh dates can be checked for each data subset within the data warehouse via header tables or by checking the extract date associated with each record within a table (these dates are being added as tables are modified by the database administrators, therefore not all tables contain these extract dates).

**What is a Database?**

A database stores information in a tabular format of rows and columns. Each row is a record containing information about a singular entity, object or event, such as a person, product or transaction.

Each record is segmented into multiple columns called fields. Fields are data entries describing standard aspects of a record, such as transaction dates, names, id numbers or dollar amounts. In a relational database, tables are joined/linked using an item common to each table. The database for the UM Data Warehouse is ORACLE.

**About BrioQuery Explorer**

BrioQuery Explorer is a query tool which provides non-technical users with easy access to valuable data stored in databases such as the UM Data Warehouse. With this tool, you can pull together information required to create information “products” such as annual reports, budget analyses and/or departmental presentations.

BrioQuery Explorer is a CLIENT program that resides on a desktop computer and that transmits SQL commands to an Oracle SERVER (that “speaks” SQL). An OCE (Open Catalog Extension) facilitates the communication between Brio and the server (see Part 5).

*It is important to note that when BrioQuery is used to manipulate data from the Data Warehouse, users are not changing the actual Warehouse data. BrioQuery facilitates the retrieval of requested data to be manipulated at the desktop.*
About BrioQuery Documents

With BrioQuery, users work in document files that consolidate the different specifications for querying, analyzing and presenting data stored on the database server.

Each BrioQuery document can include:

- a **Table Catalog** - listing of Topics to which you have access
- a **Data Model** - a graphical representation of the database
- a **query** for retrieving a subset of data from the database
- a **results** set displayed in a spreadsheet-style format
- multi-dimensional **Pivot** reports with drill-down analysis of data results
- **Reports** presenting customized views of your data
- **Tables** displaying a columnar representation of your database tables
- **Charts** that allow users to graphically display & manipulate query results

Examples of Document Sections

The following are sample reports, created with BrioQuery, to provide an idea of what the tool can accomplish.

Results Report

This Results report is the collection of columns and rows retrieved in the query. Note that you can specify a limit on the data in this section as well as sort and format.

<table>
<thead>
<tr>
<th>Coll Unit</th>
<th>Hr Dept</th>
<th>Category Status</th>
<th>Title Rank</th>
</tr>
</thead>
<tbody>
<tr>
<td>BSOS Criminology &amp; Criminal Justice</td>
<td>FACULTY, NON-REG, NON-TEN</td>
<td>Professor</td>
<td></td>
</tr>
<tr>
<td>BSOS Sociology</td>
<td>FACULTY, NON-REG, NON-TEN</td>
<td>Assoc Prof</td>
<td></td>
</tr>
<tr>
<td>BSOS Government &amp; Politics</td>
<td>FACULTY, NON-REG, NON-TEN</td>
<td>Fac Res Asst</td>
<td></td>
</tr>
<tr>
<td>BSOS Criminology &amp; Criminal Justice</td>
<td>FACULTY, NON-REG, NON-TEN</td>
<td>Fac Res Asst</td>
<td></td>
</tr>
<tr>
<td>BSOS Government &amp; Politics</td>
<td>FACULTY, NON-REG, NON-TEN</td>
<td>Fac Res Asst</td>
<td></td>
</tr>
<tr>
<td>BSOS JW Burns Academy Leadership</td>
<td>FACULTY, NON-REG, NON-TEN</td>
<td>Fac Res Asst</td>
<td></td>
</tr>
<tr>
<td>BSOS Government &amp; Politics</td>
<td>FACULTY, NON-REG, NON-TEN</td>
<td>Fac Res Asst</td>
<td></td>
</tr>
<tr>
<td>BSOS Economics</td>
<td>FACULTY, NON-REG, NON-TEN</td>
<td>Fac Res Asst</td>
<td></td>
</tr>
<tr>
<td>BSOS Criminology &amp; Criminal Justice</td>
<td>FACULTY NON-TENURED, TERM CNTR</td>
<td>Fac Res Asst</td>
<td></td>
</tr>
<tr>
<td>BSOS Geography</td>
<td>FACULTY NON-TENURED</td>
<td>Assoc Prof</td>
<td></td>
</tr>
<tr>
<td>BSOS Coll Behavioral &amp; Social Sci</td>
<td>FACULTY NON-TENURED, TERM CNTR</td>
<td>Fac Res Asst</td>
<td></td>
</tr>
<tr>
<td>BSOS Geography</td>
<td>FACULTY NON-TENURED, TERM CNTR</td>
<td>Fac Res Asst</td>
<td></td>
</tr>
<tr>
<td>BSOS Ctr Substance Abuse Research</td>
<td>FACULTY NON-TENURED, TERM CNTR</td>
<td>Fac Res Asst</td>
<td></td>
</tr>
<tr>
<td>BSOS Ctr Substance Abuse Research</td>
<td>FACULTY NON-TENURED, TERM CNTR</td>
<td>Research Assoc</td>
<td></td>
</tr>
<tr>
<td>BSOS Coll Behavioral &amp; Social Sci</td>
<td>FACULTY NON-TENURED, TERM CNTR</td>
<td>Fac Res Asst</td>
<td></td>
</tr>
</tbody>
</table>
Pivot Report
This Pivot function allows the creation of reports that cross-tabulate data in a variety of ways.

<table>
<thead>
<tr>
<th>Department</th>
<th>Assist Prof</th>
<th>Assoc Prof</th>
<th>Professor</th>
<th>Count</th>
</tr>
</thead>
<tbody>
<tr>
<td>BSOS Afro-American Studies Prog</td>
<td>2</td>
<td>3</td>
<td>1</td>
<td>6</td>
</tr>
<tr>
<td>Anthropology</td>
<td>2</td>
<td>3</td>
<td>9</td>
<td>14</td>
</tr>
<tr>
<td>Coll Behavioral &amp; Social Sci</td>
<td></td>
<td>1</td>
<td></td>
<td>1</td>
</tr>
<tr>
<td>Criminology &amp; Criminal Justice</td>
<td>4</td>
<td>4</td>
<td>8</td>
<td>10</td>
</tr>
<tr>
<td>Ctr Substance Abuse Research</td>
<td>1</td>
<td>1</td>
<td></td>
<td>1</td>
</tr>
<tr>
<td>Economics</td>
<td>7</td>
<td>10</td>
<td>22</td>
<td>33</td>
</tr>
<tr>
<td>Geography</td>
<td>1</td>
<td>8</td>
<td>5</td>
<td>14</td>
</tr>
<tr>
<td>Government &amp; Politics</td>
<td>5</td>
<td>12</td>
<td>20</td>
<td>37</td>
</tr>
<tr>
<td>Hearing &amp; Speech Sciences</td>
<td>3</td>
<td>1</td>
<td>3</td>
<td>7</td>
</tr>
<tr>
<td>JM Burns Academy Leadership</td>
<td>1</td>
<td>2</td>
<td></td>
<td>3</td>
</tr>
<tr>
<td>Joint Program Survey Meth</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>2</td>
</tr>
<tr>
<td>Psychology</td>
<td>5</td>
<td>13</td>
<td>26</td>
<td>44</td>
</tr>
<tr>
<td>Sociology</td>
<td>6</td>
<td>9</td>
<td>15</td>
<td>30</td>
</tr>
<tr>
<td>Survey Research Center</td>
<td></td>
<td>1</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>Count</td>
<td>35</td>
<td>67</td>
<td>113</td>
<td>215</td>
</tr>
</tbody>
</table>

Report
A Report is a band-style report that summarizes and creates automatic totals.

AFRO-AMERICAN STUDIES
ASSOC PROF

<table>
<thead>
<tr>
<th>Name</th>
<th>Appt Title</th>
<th>Category Status</th>
<th>Um Id</th>
</tr>
</thead>
<tbody>
<tr>
<td>Williams, Rhonda M.</td>
<td>Associate Professor</td>
<td>FACULTY TENURED</td>
<td>1</td>
</tr>
<tr>
<td>Wilson, Francille R.</td>
<td>Associate Professor</td>
<td>FACULTY TENURED</td>
<td>1</td>
</tr>
<tr>
<td>Harley, Sharon J.</td>
<td>Associate Professor</td>
<td>FACULTY TENURED</td>
<td>1</td>
</tr>
<tr>
<td>Total: 6</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

ASST PROF

<table>
<thead>
<tr>
<th>Name</th>
<th>Appt Title</th>
<th>Category Status</th>
<th>Um Id</th>
</tr>
</thead>
<tbody>
<tr>
<td>Johnson, Ollie A.</td>
<td>Assistant Professor</td>
<td>FACULTY NON-TENURED, ON TRACK</td>
<td>1</td>
</tr>
<tr>
<td>Woods, Clyde A.</td>
<td>Assistant Professor</td>
<td>FACULTY NON-TENURED, ON TRACK</td>
<td>1</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>2</td>
</tr>
</tbody>
</table>
Table Report

New tables can be created based on the rows of data stored in the Results section.

<table>
<thead>
<tr>
<th>Hr Dept</th>
<th>Appl Title</th>
<th>Title Rank</th>
</tr>
</thead>
<tbody>
<tr>
<td>Geology</td>
<td>Affiliate Professor</td>
<td>Professor</td>
</tr>
<tr>
<td>NatRes Sci &amp; Landscape Arch</td>
<td>Professor &amp; Director</td>
<td>Professor</td>
</tr>
<tr>
<td>Nutrition &amp; Food Science</td>
<td>Professor</td>
<td>Professor</td>
</tr>
<tr>
<td>Materials &amp; Nuclear Engr</td>
<td>Assistant Professor</td>
<td>Assist Prof</td>
</tr>
<tr>
<td>History</td>
<td>Distinguished University Professor</td>
<td>Professor</td>
</tr>
<tr>
<td>Inst Phys Sci &amp; Tech</td>
<td>Distinguished University Professor</td>
<td>Professor</td>
</tr>
<tr>
<td>Women’s Studies</td>
<td>Affiliate Professor</td>
<td>Professor</td>
</tr>
<tr>
<td>Geography</td>
<td>Associate Professor</td>
<td>Assoc Prof</td>
</tr>
<tr>
<td>Philip Merrill Coll Journalism</td>
<td>Assistant Professor</td>
<td>Assist Prof</td>
</tr>
</tbody>
</table>

The Table report is a subset of the Results section, so it will not be covered in this course.

Features and Tools of Your Desktop

There are a number of features and tools included in the BrioQuery screen display that are very useful. These include: the menus, section tabs, toolbars, lines, status bar and Advisor window.

Menus

The first menu bar shown is from the Query section and will be the menu bar shown when first entering the BrioQuery Enterprise program. Each section of BrioQuery has its own menu bar. While the File and Edit menus are standard across all sections, other menus will appear depending on which section is active.
Note: When BrioQuery is launched, the toolbars are displayed as they were the last time BrioQuery was open on the desktop.

Sections

Along the left side of the BrioQuery document window is the Section Pane. There is a tab for each section. The tabs allow quick access to every section of the BrioQuery document: Query, Results, Pivot, Chart and Report and Table sections.

There can be multiple Pivot, Chart and/or Reports and therefore, multiple Pivot, Chart and/or Report section tabs.

Toolbars

BrioQuery has three toolbars that enable quick access to commonly used menu commands: Standard, Format and Section. Toolbars can be displayed or hidden depending on the user’s needs. Any toolbar can be shown by selecting the appropriate option from the View/Toolbars menu.

The choice of whether to use the toolbar or the menus is a personal one. In BrioQuery there are usually at least three methods for performing most activities: a button on a toolbar, menu option, right-click speed menu or a graphical drag & drop method.

The Standard toolbar is extremely useful. Several features from the menus are duplicated in the Standard toolbar. Therefore, if the Standard toolbar is not used, various menus can be used to perform the same functions. The functions available via the buttons on the Standard toolbar are: New Document, Open Document, Save, Print, Print Preview, Format Painter, Show Section/Catalog, Insert New, Properties, Limit, Sort Ascending, Sort Descending, Grand Total, Group Labels, Connect, Disconnect, Back, Forward, Home and Help.

The Format toolbar is a graphical representation of the functions supported by the various options in the Format menu. The Format toolbar is useful for making changes in all the report sections: Results, Pivot, Chart and Detail.
Specific Section toolbars are available in the Chart, Report and EIS sections.

Chart section buttons include Chart Type, Set Legend On and Zoom

Report section buttons include Alignment, Make Same Size, Layer, Set Spring and Zoom

Command Lines

The Request Line is the area in which data items (columns) are placed. Data for these items will be returned from the database.

The Limit Line displays the constraints set on particular items by the user. The Limit Line in the Query section displays only those limits set in the Query section. These limits are performed on the data in the database. The Limit Line in the Results section displays only those limits set in the Results section and does not include the Limit Line extension. These limits are performed at the user’s desktop on the data set returned from the database.

Query Section

Results Section

To view the Limit Line the user can click on the Limit button that is used to toggle the line of and off. The number in parenthesis on the Limit button, denotes how many data items are being used in the limit.

The Sort Line in the Query and Results section are similar. Items can be dragged from the Request Line to the Sort Line to sort the data, based on that item, in ascending or descending order. When items are included on the Sort Line in the Query section, the sorting is performed by the server. In contrast, when items are included on the Sort Line in the Results section, the sorting is performed by the client (end user’s computer).
To view the **Sort Line** the user can click on the Sort button \( \text{Sort}(0) \) that is used to toggle the line on and off. The number in parenthesis on the Sort button, denotes how many data items are being used in the sort.

The Sort Lines in the Pivot, Chart and Detail sections are also similar. Complex sorting can be accomplished by choosing various options in the pop-up menus on the Sort Line.

---

**Note:** Use caution when sorting SIS data in the Query section (sorting done by server). System resources should be considered during peak work hours and registration times.

---

**Status Bar**

At the very bottom of the BrioQuery document window is the Status bar. This feature displays information about the current database connection, number of rows returned, number of topics on the desktop and help messages as you move the cursor to different areas of the workspace. A red X through the connection icon indicates the workstation is not connected to the database server.

Status Bar of a BrioQuery document that is connected to the database server

Status Bar of a BrioQuery document that is not connected to the database server
Brio Help

Online Help is available for BrioQuery Explorer.

=> Choose Help from the Help menu.

UM BrioQuery & Data Warehouse Help

BrioQuery Support - support for BrioQuery Enterprise Explorer query tool call:

Lori Kasamatsu x51713

Data Warehouse Support - support for general use & specific data subsets call:

General User Support   Lori Kasamatsu   x51713

Faculty Data   Marla Bonner      x57467   Siemy Khan      x53405
Financial Aid     Robert Riggs   x48288
Human Resources   Kim Colbert or Natalie Torres   x55664
Coeus           Kurt Flick   x56270
Student Registration & Student Records Tim Malone x48245

For questions regarding frozen personnel and/or student data conducted by IRPA, send email inquiries to: irpa@umd.edu
The Format of this Training Manual

This syllabus is separated into five sections: Introduction, Creating Queries and Retrieving Data, Refining Queries and Creating Pivot Reports, Report Designer and Preparation for Using BrioQuery at Your Desktop.

There are demonstrations to show how to utilize BrioQuery, as well as independent exercises after the demonstrations to provide practice.

In each demonstration, the $\Rightarrow$ symbol will denote a necessary step to be performed.

Since there are usually several different methods of performing a task, the • symbol will denote an alternative method.

Some sections will be marked FYI. These sections will not be covered at length in class, but should serve as future reference information.

Information will be provided in a two-step format: first, the instructor will explain a new skill/feature and, second, you will perform the task at your desktop while the instructor simultaneously performs the task on the projector.
Part 2:

Creating Queries and Retrieving Data

In this chapter you will learn how to:

- Log onto the UM database.
- Select a Topic from the Table Catalog.
- Create simple queries that extract columns and rows of data.
- Sort the reported data in the Results section.
- Enhance the display of information.
- Set simple limits in the Query section, as well as the Results section.
- Perform a table join to create a two topic Data Model.
Logging onto the Database

Begin by launching BrioQuery 6 on the desktop.

⇒ If it is not already open at the workstation, launch the BrioQuery application. You will receive the a Welcome to BrioQuery window.

In order for your pc client to connect to the server database it needs to have a file that is called an Open Catalog Extension (OCE). This file contains commands that tells your workstation where to find the server database to which you want to connect on the network. Your technical support staff will have installed this file when BrioQuery and SQL*NET were loaded. You can log onto the database by selecting Browse in the Recent Data Base Connection Files section and selecting the appropriate .oce file. At the end of this course we will revisit the concept of OCE’s and customizing your desktop’s OCE file.
To log onto the database using the **Welcome to BrioQuery window**:  

- Click **Browse** to the right of the section called, **Recent Database Connection Files**.
- A **Select Connection** dialog box appears. Select the **OCE** filename and click on **Open**.  
  - If the **OCE** filename appears in the **Recent Database Files** section, select the **OCE** filename and click **OK**.

A log on dialog box appears. The OCE filename is displayed in the title bar of the dialog box.

- Enter **your user name** and **password** and click on **OK**.

![Image of the DW1.ace dialog box](image)

When the connection to the database is established, BrioQuery indicates that the connection has been made by displaying a connection icon (looks like a barbell) in the status bar area of the BrioQuery window.

When the cursor passes over the Connection icon (do not click), a message will appear to the left on the Status bar. This provides information on which OCE and server software is currently being used.

### Selecting a Topic from the Table Catalog

To display a topic to which you have been given access:

- Click on the + next to the word **Tables** in the Catalog section of the Section/Catalog Pane. This will display the list of tables for which you have been given access.

![Image of the Tables section](image)
Click on any topic in the **Catalog Pane** and drag it to the workspace.
- Double-click on any topic.
- Click on any topic, right-click, select **Add Selected Items** on speed menu.
- Click on **Query** in the menu bar, **Add Request Item(s)**

**Data Models** consist of one or more topics that appear on the workspace. The above example is a single topic Data Model. The Data Model can be viewed in several ways:

A topic is in **Structure view** when the name of the topic (table) is the title of the topic window and the items (columns) are listed below the topic window header. The topics in the above Data Model are in structure view.

To get a better understanding of the actual data that resides in a table, highlight the topic name, right-click and toggle on the **Detail View**. A default of 10 rows will be read and returned from the database. All of the columns are returned with this function, allowing the user to scan the actual data before selecting an item.
A topic can also be reduced to an icon view if desktop is cluttered. This is not recommended - a topic in icon view is easy to forget and can impede future querying. To reduce a topic to icon view, highlight the topic name, right-click and toggle on the **Icon View**.

![Icon View](image)

To return to structure view, highlight the topic name, right-click and toggle on the structure view.

Remove the topic from the workspace and close **Table Catalog**:

- Highlight the topic name, press **Delete**.
  - Highlight topic name, press the **X** button on the Standard toolbar.
  - Highlight topic name, right-click, select **Remove** on speed menu.
- Close **Table Catalog** by clicking on – next to the word Tables in the **Catalog Pane** section of the **Section/Catalog**.
Demonstrations 1, 2 & 3

We will use three demonstrations to discuss the methods involved in creating simple queries and retrieving results from a database. In the first demo, you will learn to create a query and to use the basic query functions such as Add, Remove, Modify and Process. You will also learn how to format and sort the output results. In the second demo, you will learn how to add local Limits to the query from the first demo. In the third demo, you will learn how to perform a manual join to create a two topic Data Model. These demos are meant to be mentor-led, hands-on experiences.

Demo 1:

Goal: To show a list of all current appointees, along with their Department, College and Appointment Title.

This query will retrieve information that shows all current ARS appointments in the Academic Affairs Division with Appointment Titles. The final list will be a current, active ARS appointee roster by college, by department and in alphabetical order by name.

Your final report should look similar to the following:
[Pay special attention to the format and not the data specifically as changes may occur due to the dynamic nature of current, active appointments.]
Creating the Query

A query is created in the Query section of the BrioQuery document (note the section name Query to the left of your workspace) by placing data items (columns) from a topic (table) onto the Request Line.

- From the panel on the left, click on the + sign next to the Tables folder in the Catalog Pane.
- Select ARS_Current_Appts topic and drag it to the workspace.
- Double-click on the topic.
- Click on the topic, right-click, select Add Selected Items on speed menu.
- Click on the topic, select Query menu and select Add Request Item(s).
- Add data items: Coll Unit, Hr Dept, Name and Appt Title (in this order) to the Request Line by clicking and dragging each data item to the Request Line.
- Click on item, right-click, select Add Selected Items on speed menu.
- Click on item, select Query menu and select Add Request Item(s).
Rearranging/Removing items on the Request Line

Items can be rearranged on the Request Line by dragging them into a different order within the Request Line. Items can also be removed. If an item is added in error, simply select that item in the Request Line and press the Delete key.

- Select the item in the Request Line and click the Remove button on the Standard Toolbar
- Select the item in the Request Line and drag it off the Request Line.

Adding all items in a topic to the Request Line

If all of the items in a topic will be selected for a query, select the topic name in the topic description window and select Query in the menu bar and click Add Request Item(s).

- Select the topic name in the topic description window, right-click and select Add Selected Items on speed menu. This will cause the topic items to be added to the Request Line.

Removing all items from the Request Line

If all of the items on the Request Line need to be removed, click on the Request button to the left on the Request Line and click the Remove button on the Standard toolbar.

- Select the Request button and press the Delete key.
- Select the Request button, right-click and select Remove on speed menu.

Selecting contiguous and non-contiguous items from a topic

To select contiguous items from a topic, use shift-click. To select non-contiguous items from a topic use ctrl-click (command-click).

Processing the Query

In order to obtain results, the query needs to be processed. To do this,

- Click the Process button on the Standard toolbar. Status information will appear on the Status bar regarding the processing of the request and the data being retrieved.

Cancelling a query:

At any time, after the first row of data is returned, the query can be canceled by pressing the Alt-End (Command-Period) key sequence on the keyboard.

HOWEVER, the database will still continue to process the query on the data warehouse database server, even though it has been stopped on the user’s workstation.

For this reason, it is extremely important that the user send an email message immediately to DBA staff at: eti-edbs@umd.edu so that the query can be cancelled on the database server. Be sure to include your DW username in the message and let the DBAs know that your query was running on the DW.
When processing is complete, the **Status bar** will detail the number of rows returned. In addition, the active workspace will now be in the **Results** section of the document (note the section selected in the Section Pane to the left of the workspace). The **Results** now reside on your pc client.

### Restricting the Number of Rows Returned

BrioQuery provides an option to restrict the number of rows returned from a query. This feature is useful if the user wishes to test a query on a small amount of returned data or analyze a small result set. To set the query to return a specific number of rows:

1. Click the **Query section tab** to return to the **Query** section.
2. Double-click on the **Request** button to display the **Modify Request** dialog box.

![Modify Request dialog box](image)
In the Process area of the dialog box, enter the number of rows desired, i.e. 20, and click on Return First box which will place a check mark in the box.

Click OK

Reprocess the query. Click the Process button on the Standard toolbar.

Upon processing the query and returning to the Results section, a dialog box will appear alerting the user to the retrieval of a limited number of rows:

The Status bar will read “20 of 20 Rows” detailing the maximum number of rows specified.

For the purposes of our demonstration, remove this restriction and reprocess the query.

Click the Query section name to return to the Query section.
Double-click on the Request button to display the Modify Request dialog box.
Click on the Return First box to uncheck this restriction.
Click on OK.
Click the Process button on the Standard toolbar.

Moving Columns in Results Section
To move or rearrange columns in the Results section, click and drag the column to the desired location or click and drag the items in the Request Item section. Note that moving the columns in the Results section rearranges the data items as they were listed on the Request Line.
Sorting in the Results Section

It is often desirable to sort the query results into a more useful order. Sort your query results in alphabetical order by the name of the college.

✦ Select the Coll Unit column by clicking anywhere in the column.
✦ Click the A-Z button on the Standard toolbar. The data will automatically be sorted in alphabetical order by college.

FYI If sorting in descending order is desired, the Z-A button on the Standard toolbar can be used.

It is also possible to do more complex sorting, termed “nested sorting,” using the Sort Line. To toggle the Sort Line on (and off if it is already displayed):
✦ Click on which appears above the columns

When sorting more than one data item at a time, the left to right order of data on the Sort Line indicates the sort order and creates a nested effect. The item to the left on the Sort Line is sorted first. Then items to the right are sorted in progression, each within the categories of the preceding item. Sort your query results by college, then by department and then alphabetically by name.

✦ Drag the Hr Dept column to the Sort Line to the right of Coll Unit (already on the sort line from the original sort with A-Z button). Release the mouse when the cursor appears in the Sort Line.
✦ Repeat this procedure with the Name column.
✦ Click the Sort Now button on the Sort Line.

Upon clicking the Sort Now button, the data will be sorted dynamically in ascending sequence by default.

Sorting can also be done in the Query section. When sorting in the Query section, the server is performing the task and when sorting in the Results section, the client is performing the task.

Remember!! Use caution when sorting in the Query section. Please consider system resources.
Enhancing the Display of Information

Adjusting Column Widths & Setting Text Wrap
There are several options for setting column widths in the Results and Reports sections. Resize the **Hr Dept** and **Name** columns to display data items in their entirety.

- Select the column by clicking anywhere in the column and positioning the cursor over the right boundary of the column to be resized.
- When the cursor changes to a two-headed arrow, double-click.
- Select the column, position the cursor over the right boundary of the column to be resized. When the cursor changes to a two-headed arrow, drag the column boundary to the desired width.
- Select the columns to be resized (shift-click since they are contiguous), select **Format** from the menubar, **Column**, click on **Auto-Size Width**.

To display data items in their entirety without lengthy column widths, BrioQuery allows the wrapping of text. Apply text wrap to the **Appt Title** column then manually resize the column.

- Click inside the column to select it.
- Click **Format** from the menu and click on **Text Wrap**.
- Click on the column, right-click and select **Text Wrap**.
- Resize the column by positioning the cursor over the right boundary of the column and dragging it to a width that wraps the text to two lines.

Note that auto resizing by double-clicking or Format/Column/Auto-Size Width methods eliminate text wrap if it has already been applied. If text wrap is applied prior to resizing any of the columns, text wrap will apply to all columns of data.

Formatting Numbers, Dates and Times
There are several ways to format the display of numbers, dates and times. Although it does not apply to our current results set, the following are the methods used to reformat the display of numbers, dates and times. FYI

- Click on the column of data to be reformatted.
- Click on **Format** in the menubar, click **Number** which will display a **Properties** window from which you can select the new format choice from the list.
- Click on the column, click on **Format**, click **Number** and select the new format choice from the list.
- Click column, right-click, click **Number** on the speed menu and select the new format choice from the list.

Suppressing Duplicate Values
It may be advantageous in reporting results to eliminate repetious data. Eliminate duplicate values in both the **Coll Unit** and **Hr Dept** columns.

- Select the columns in which duplicate values will be suppressed (shift-click since they are contiguous), click on **Format** in the menubar and click on **Suppress Duplicates**
- Select the columns, right-click and select **Suppress Duplicates** from the speed menu.
When this option is active, BrioQuery displays only the first instance of a value in a continuous selection of identical values inside a column.

You have now achieved the goal set forth at the beginning of this demo.

DO NOT CLOSE THIS QUERY, WE WILL WORK WITH THIS SAME QUERY IN DEMO 2.
Demo 2:

**Goal:** To narrow the focus of the list of all current appointees to a list of those tenured and tenure-track faculty members within the College of Behavioral and Social Sciences. Upon evaluating the Results, narrow the scope of list even further to only include those with the title of Associate Professor.

In this demonstration, the query from Demo 1 will be modified by adding limits in both the **Query** section and the **Results** section.

The final report should look as follows:

[Pay attention to the format and not the data specifically as changes may occur due to the dynamic nature of current, active appointments.]

### Limits

Limits enable the user to narrow the request and filter away the data not needed. Limiting allows the user to work with relevant data, saving time and conserving the resources of the database and the network. Local limits are applied in the Results section and exclude information from the data set which is retained in the document.

<table>
<thead>
<tr>
<th>Coll Unit</th>
<th>App Title</th>
<th>Dept</th>
<th>Sit</th>
<th>Hr Dept</th>
<th>Name</th>
<th>Appl Title</th>
</tr>
</thead>
<tbody>
<tr>
<td>BBOS</td>
<td>Afro-American Studies Prog</td>
<td></td>
<td></td>
<td></td>
<td>Harvey, Sharon</td>
<td>Associate Professor</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Wilson, Ernest J.</td>
<td>Associate Professor</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Wilson, Franklin R.</td>
<td>Associate Professor</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Prokic, Judith N.</td>
<td>Associate Professor</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Kim, Geun-Young</td>
<td>Affiliate Associate Professor</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Shackle, Paul A.</td>
<td>Associate Professor</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Steele, Robert E.</td>
<td>Associate Professor &amp; Associate Dean</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Russell, Kathryn K.</td>
<td>Associate Professor</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Russell, Kathryn K.</td>
<td>Associate Professor</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Simpson, Sally S.</td>
<td>Associate Professor</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>With, Eric D.</td>
<td>Associate Professor &amp; Director</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Doughlin, Peter J.</td>
<td>Associate Professor</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Hellebrand, Judith K.</td>
<td>Associate Professor</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Kranton, Rachel E.</td>
<td>Associate Professor</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Lyon, Andrew B.</td>
<td>Associate Professor</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Minehart, Deborah</td>
<td>Associate Professor</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Sande, Patricia</td>
<td>Associate Professor</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Sodgers, Seth Gay</td>
<td>Associate Professor</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Shes, John</td>
<td>Associate Professor</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Smith, Jeffrey Andrew</td>
<td>Associate Professor</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Vincent, Daniel J.</td>
<td>Associate Professor</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Bird, William</td>
<td>Associate Professor</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Dinnisone, Joseph</td>
<td>Associate Professor &amp; Associate Chair</td>
</tr>
</tbody>
</table>

### Notes

- [Dynamic nature of current, active appointments]
- [Pay attention to the format]
- [Changes may occur due to the dynamic nature of current, active appointments]
Limiting in the Query Section

A limit applied in the Query section instructs the database server to filter unwanted information from the request. Only the filtered data is returned to your desktop. Limits can be placed on any data item in the Data Model in the workspace. It is not necessary to “Request” the data items on which limits are being set. To set the limits for this query:

⇒ The Limit Line must be displayed. If not already present on the desktop, click on the Limits button above the Request Line.
⇒ Double-click on the data item, **Coll Unit Cd** upon which filtering will take place.
⇒ Click on data item and drag to limit line
⇒ Click on data item and click the Limit icon on the standard toolbar.

A limit dialog box will appear.

![Limit dialog box](image)

Features of the Limit Dialog Box

- The Name of the item upon which a limit will be set.
- Include Nulls if you want to include blanks (nulls)
- A drop-down menu consisting of many comparison (logical) operators.
- An Ignore button that allows the temporary removal of a limit.
- A Not option that enables the negation of any operator.
- A Custom Values button which enables the user to type the specific criteria. Use commas between multiple values and click on the green check mark to enter the values into the Custom Values view.
- A Show Values button which retrieves a list of the unique, current values for the data item from the database.
- A Custom SQL button that allows the user to type in the SQL commands. This option should only be used by those who understand the Structured Query Language.
- A Select All button that selects all the values for limiting.
- A Remove button to remove selected values from the Custom Values list.
- An Advanced button to load data from another source or to create a subquery.
- A Help button to access the online help regarding applying limits.
For this particular limit:

- Select the ‘=Equal’ operator (the default) from the list of comparison operators.
- Click Show Values. Select 128 - BSOS from the list of college unit codes.

- Click OK.

Notice the equal sign next to Coll Unit Cd in the ARS_Current Appts topic window. This denotes a limit of “equal” has been placed on that item.

A “Not Equal” operation is represented by a != before the data item.
For example, != Coll Unit Cd
The Limit Line in the Query section now contains Coll Unit Cd, even though Coll Unit Cd is not a part of the Request Line.

To have remarks available at your desktop, review Appendix A or forward to your technical support staff for their review.

Proceed with setting a limit to retrieve only those appointees who are tenured or tenure-track. To do this, a limit will be placed on the Ten Tentrk Faculty data item. To get a better understanding of this data item, the user can view Remarks. Remarks are available for each data item in the UM Data Warehouse.

- Click once on the data item, Ten Tentrk Faculty and press Ctrl-I (key sequence).
- Click once on data item, select Query from the menubar and click Show Remarks…
- Click once on data item, right-click and select Show Remarks

- Click on OK to clear the Remarks window.
- Pull up a limit dialog box using one of the three possible methods.
- Use the default “=Equal” operator.
- Because this is a Yes/No field, type in the letter “Y” as a Custom Value.
- Press Show Values button and click on Y - Yes
- Click OK.
The **Limit Line** in the **Query** section now contains **Coll Unit Cd** and **Ten Tentrk Faculty** joined by default with an AND operator, to reflect that both limits apply and that the data must meet both conditions.

Processing the Limited Query

Now that two limits have been added, process the query.

=> Press the **Process** button on the Standard toolbar.

Review the limited Results. The data should reflect only tenured and tenure-track faculty in the College of Behavioral and Social Sciences.
Limits – Revisited

Limiting in the Results Section

Limits in the Results section can only be placed on data items included in the query’s returned results. A limit placed in the Results section places a limit on data already retrieved and reports a smaller set of that data. A Results limit allows the user to focus data searches and reports without the necessity of retrieving the data from the database again and again. A Results limit can be removed and all of the retrieved data will again be viewable without having to reprocess the query.

In order to focus this results data set further to include only those tenured and tenure-track faculty in the College of Behavioral and Social Sciences who hold the appointment title of Associate Professor:

⇒ The Limit Line in the Results section must be toggled on. If not already present on the desktop, click on the button above the column headers to toggle on the Limit Line.
⇒ To set the limit, click and drag the Appt Title column name to the Limit Line. Release the mouse button when the cursor dragging the column appears in the Limit Line.
⇒ Double-click anywhere in the Appt Title column.
⇒ Click on Appt Title column, click on Results in the menubar and select Limit…
⇒ Click on Appt Title column, click on the Limit button in the standard toolbar.
⇒ Select the “Contains” operator from the list of comparison operators.
⇒ Type in “Associate Professor” (the data elements are case sensitive so you must use mixed case as shown in the example) as a Custom Value.
⇒ Select Associate Professor using Show Values feature.
⇒ Click on OK

The Results report is automatically updated to reflect the limit. Notice the rows returned on the Status bar. Suppress duplicates is still toggled on for Coll Unit and Hr Dept.
You have now achieved the goal set forth at the beginning of this demo.

[DO NOT SAVE DEMO QUERY IN LAB]

Saving and Closing a Query

FYI  To save a BrioQuery document:
Save Options.
If saving the results data, compressing the size of any BrioQuery document you
save or password protection for a document is desired, you can select specify that
you want to save those options before you save your BrioQuery document.
⇒ Click File from the menubar, click Save Options and click on a selection. Note:
   You can select more than one option, by accessing the Save Options menu as
   many times as needed.

Save and Save As…
⇒ Click File from the menubar, click Save to save the document for the first time or
   ‘over’ the original if desired.
⇒ Click the Save button on the standard toolbar.
Or
⇒ Click File from the menubar and click Save As… to save the document with a
   new filename.

FYI  To close a BrioQuery document:
⇒ Click File on the menubar and click Close.
⇒ Click the X button in the top right-hand corner of the BrioQuery document
   window
What is a Join?

In a relational database system, tables share information through links (joins) between common data items in the different topics (tables). Joins are used to group together data stored in different tables. Relationships in the Data Model are represented by creating joins between topic items. This capability simplifies the querying process.

Auto Joins

When you drag topics onto the workspace to build a Data Model, lines may appear that join the tables together. In the DataModel menu, there is an Auto-Join feature that, if toggled on, will automatically join data items of the same name and datatype. Although intended to be helpful, this feature can be overwhelming when tables on the workspace share many common data items and the user only wishes to join the tables on one data item.

To turn off the Auto-Join feature:

⇒ Click DataModel from the menubar, click Data Model Options..., click the checkmark next to Auto join tables which will remove it (if there is no checkmark displayed it means that option is turned off).
⇒ Click OK.

Manual Joins

To join two or more tables manually, a common data item must be dragged from one table over to the second table and dropped on top of the same data item in the second table.

⇒ From the Query section, open a new document, click File from the menubar and click New.
⇒ Click on the New Document button in the standard toolbar.

An auto-logon message will appear:


⇒ Click on Yes. A new document will be opened on the desktop and if you have the left Section/Pane frame turned on you will see the Tables folder. If you do not see the Section/Pane frame, click View from the menubar, Section/Pane.
⇒ Move ARS_Current_Appts and ARS_Degree_Information topics to the workspace.
⇒ Drag the U Id data item from the ARS_Current_Appt table over to the U Id data item in the ARS_Degree_Information table and release the mouse button.
Viewing the Type of Topic Join

Notice the line that appears to link the two tables together. The equal sign embedded in the join line indicates that a simple “equal” join has been created between the two tables. For more information about the type of join:

- Double-click on the join line between the two tables.
- Click once on the join line and click on the Properties button on Standard toolbar

A Join Properties window will appear:

This particular join is “simple” and BrioQuery is set to retrieve rows where joined columns have equal values. Notice it is also possible to have several other types of joins, including left and right joins. Data training will devote more time to the discussion and use of joins.

- Click OK to close the Join Properties dialog box.
Demo 3:

**Goal:** To produce a listing of all current ARS appointees in the College of Behavioral and Social Sciences that details their appointment title and degrees earned.

This query will use the two topic Data Model joined on data item **U Id** just created in the lesson. It will retrieve information that shows all current ARS appointments in the College of Behavioral and Social Sciences with Appointment Titles and Degrees earned. The final list will be ordered by college, by department, by appointment title and in alphabetical order with degrees ordered by degree code.

Your final report should look like the following:

[Pay special attention to the format and not the data specifically as changes may occur due to the dynamic nature of current, active appointments.]

<table>
<thead>
<tr>
<th>Unit</th>
<th>Hr Dept</th>
<th>Apt Title</th>
<th>Name</th>
<th>Degree Cd</th>
<th>Degree</th>
</tr>
</thead>
<tbody>
<tr>
<td>BSOS</td>
<td>African American Studies</td>
<td>Assistant Professor</td>
<td>Nembhard, Jessica G</td>
<td>10</td>
<td>B.A.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>30</td>
<td>M.A.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>30</td>
<td>M.A.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>60</td>
<td>Ph.D.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Woods, Clyde A.</td>
<td></td>
<td>10</td>
<td>B.A.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>38</td>
<td>M.G.P.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>60</td>
<td>Ph.D.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Associate Professor</td>
<td>Wilson, Ernest J.</td>
<td>10</td>
<td>B.A.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>30</td>
<td>M.A.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>60</td>
<td>Ph.D.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Wilson, Francille R.</td>
<td></td>
<td>10</td>
<td>B.A.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>30</td>
<td>M.A.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>59</td>
<td>M.O.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>60</td>
<td>Ph.D.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Associate Professor</td>
<td>Harley, Sharon</td>
<td>10</td>
<td>B.A.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>30</td>
<td>M.A.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>60</td>
<td>Ph.D.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Coordinator</td>
<td>Pharm-Maletta, Nellic E</td>
<td>10</td>
<td>B.A.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>33</td>
<td>M.B.A.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Director Administrative</td>
<td>Skeeter, Valencia L</td>
<td>11</td>
<td>B.S.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Lecturer</td>
<td>Karbo, Ibrahim</td>
<td>10</td>
<td>B.A.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>30</td>
<td>M.A.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>60</td>
<td>Ph.D.</td>
</tr>
<tr>
<td></td>
<td>Anthropology</td>
<td>Adjunct Assistant Prof</td>
<td>Keljoe, Linda Marie</td>
<td>10</td>
<td>B.A.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>42</td>
<td>M.A.A.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td>60</td>
<td>Ph.D.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Wilczak, Cynthia A.</td>
<td></td>
<td>11</td>
<td>B.S.</td>
</tr>
</tbody>
</table>
Creating a Query Using A Two Topic Data Model

- Add data items: **Coll Unit, Hr Dept, Appt Title** and **Name** from the **ARS_Current_Appts** topic to the **Request Line**.
- Add data items: **Degree Cd** and **Degree** from the **ARS_Degree_Information** topic to the **Request Line**.
- Limit the query on data item, **Coll Unit Cd = 128**
- Process the query.
- Create a nested sort of the results by **Coll Unit, Hr Dept, Appt Title, Name** and **Degree Cd**.

<table>
<thead>
<tr>
<th>Coll Unit Cd</th>
<th>Hr Dept</th>
<th>Appt Title</th>
<th>Name</th>
<th>Degree Cd</th>
<th>Degree</th>
</tr>
</thead>
<tbody>
<tr>
<td>1830</td>
<td>JMBurnsAcadLeadership</td>
<td>Associate Research Scholar</td>
<td>Wilson, Ernest J.</td>
<td>18</td>
<td>B.A. - Bachelor of Arts</td>
</tr>
<tr>
<td>1830</td>
<td>JMBurnsAcadLeadership</td>
<td>Associate Research Scholar</td>
<td>Freeman, Paul</td>
<td>18</td>
<td>B.A. - Bachelor of Arts</td>
</tr>
<tr>
<td>1830</td>
<td>JMBurnsAcadLeadership</td>
<td>Associate Research Scholar</td>
<td>Allen, Kathleen</td>
<td>18</td>
<td>B.A. - Bachelor of Arts</td>
</tr>
<tr>
<td>1830</td>
<td>JMBurnsAcadLeadership</td>
<td>Associate Research Scholar</td>
<td>Banks, John C.</td>
<td>18</td>
<td>B.A. - Bachelor of Arts</td>
</tr>
<tr>
<td>1830</td>
<td>JMBurnsAcadLeadership</td>
<td>Associate Research Scholar</td>
<td>Cheney, Cynthia</td>
<td>18</td>
<td>B.A. - Bachelor of Arts</td>
</tr>
<tr>
<td>1830</td>
<td>JMBurnsAcadLeadership</td>
<td>Associate Research Scholar</td>
<td>Ciri, Maria A.</td>
<td>18</td>
<td>B.A. - Bachelor of Arts</td>
</tr>
<tr>
<td>1830</td>
<td>JMBurnsAcadLeadership</td>
<td>Associate Research Scholar</td>
<td>Davis, Lawrence J.</td>
<td>18</td>
<td>B.A. - Bachelor of Arts</td>
</tr>
<tr>
<td>1830</td>
<td>JMBurnsAcadLeadership</td>
<td>Associate Research Scholar</td>
<td>Dunn, Susan</td>
<td>18</td>
<td>B.A. - Bachelor of Arts</td>
</tr>
<tr>
<td>1830</td>
<td>JMBurnsAcadLeadership</td>
<td>Associate Research Scholar</td>
<td>Farrell, Morgan</td>
<td>19</td>
<td>B.A. - Bachelor of Arts</td>
</tr>
</tbody>
</table>

You have now achieved the goal set forth at the beginning of this demo.
Exercise 1: Current Appointments List

Goal: To create a list of current regular Exempt appointees in the College of Behavioral and Social Sciences with Appointment Titles that contain the word, "Coordinator".

This query should return a report that has the columns **Coll Unit, Hr Dept, Name, Appt Title** and **Category Status**.

It should be filtered in the **Query** section to return data for those staff who are in one of the two Exempt categories (**Category Status Cd** = 33 and 34) within the College of Behavioral and Social Sciences (**Coll Unit Cd** for BSOS is 128).

In the **Results** section the data set can be further limited to display only those with **Appt Title containing** the word Coordinator (use the operator "Contains"). The report should be sorted (a nested sort) by college, by department and by name; duplicates should be suppressed on both college and department; and the column widths should be resized so all text is in view.

The final report should look like this:
[Compare to the following graphic for format only and not the data specifically as changes may occur due to the dynamic nature of current, active appointments.]
**Preparation**
1. Click **File** menu and select **New**.
   - Press on the Standard toolbar.
2. Click “Yes” when asked if you want to automatically logon. Brio will automatically log you on using the same OCE and open up a new document.
3. Move the **ARS_Current_Appts** topic onto the workspace.

**Detailed Exercise Steps**
Try performing the exercise on your own, but if you get stuck, the following steps will help you complete this exercise:

1. Add the items **Coll Unit**, **Hr Dept**, **Name**, **Appt Title** and **Category Status** to the **Request Line**.

2. Toggle on the **Limit Line** in the **Query** section by clicking on the [Limits(0)] button above the **Request** line (if the limit line is not already displayed).

3. Limit the query (in the **Query** section) by setting **Coll Unit Cd** = 128 and **Category Status Cd** = 33 and 34.

4. Process the query and review the data returned.

5. Toggle on the **Limit Line** and **Sort Line** in the **Results** section by clicking on the [Limits(0)] and [Sort(0)] buttons (if the limit line or sort line is not already displayed).

6. Limit the **Results** by setting **Appt Title** to ‘Contains’ Coordinator.

7. Perform a nested sort by placing **Coll Unit**, then **Hr Dept** and then **Name** on the **Sort Line** (remember to press the **Sort Now** button).

8. Suppress duplicates on **Coll Unit** and **Hr Dept**.

9. Resize the column width for all columns.

10. Compare your results report to the graphic on the previous page.
Summary

In this chapter you have learned the basics of creating queries, limiting and enhancing your results. The following is a review of the important points:

- The Query section contains a Data Model that is obtained from the Catalog Pane. You need to be logged on before a query can be built.

- The Results received will depend on the items selected from the Data Model and added to the Request Line. You can change the order of the items after you have set up the Request Line.

- Limits on an item can be set in the Query section to filter unwanted information from the request. Only the filtered data is returned to the desktop. Limits can be placed on any data item in the Data Model and are not restricted to only those appearing on the Request Line.

- In the Results section, local limits can be set to exclude or focus on information from the data set which is retained in the Results section. Local limits can only be placed on data items returned in the query request (those data items on the Request Line).

- Remarks for each data item can be viewed by highlighting the data item in the topic and pressing Ctrl-I. Remarks provide the user with a better understanding of the data item by displaying the data item’s definition.

- Most functions can be performed using at least three different methods:
  - speed menu via a right-click (Ctrl-click) on the mouse.
  - toolbars
  - menus

- The Show Values button in the Limit dialog box displays database values that can be used to limit the results.

- Columns can be resized in the Results section by double-clicking or dragging the cursor when it becomes a bi-directional arrow over the right boundary of the column or by using the Auto-Size Width command on the Format, Column menu.

- Sorting can be easily accomplished in the Results section by selecting the column to be sorted and pressing one of the sort buttons, A-Z or Z-A, on the Standard toolbar or by dragging the columns to the Sort Line. The Sort Line is used to perform nested sorts.

- Data in the columns can be formatted by selecting the column and using any of the options available in the Format menu.

- Results can be customized by selecting a column and using any of the options available in the Results menu.

- The Auto Logon feature can be a time-saving device when creating more than one query at a time on the desktop.
- **Joins** can link two or more topics based on a common data item to create a multi-topic **Data Model**.

- Although a simple **equal join** is the default, there are other, more complex, joins available such as **left** and **right joins**.
Part 3:

Refining Queries and Creating Pivot Reports

In this chapter you will learn how to:

- Create simple Pivot Reports using the Outliner.
- Change the data function of a data value in a Pivot Report.
- Add totals to a Pivot Report.
- Use the “pivoting” feature of a Pivot Report.
- Use features in Print Preview mode.
- Print a report.
Pivot Reports

Pivot reports provide a rapid way to summarize data, enabling the user to cut through the detail to reach a meaningful interpretation of the query results. Data summary is a simple drag and drop operation. With the flexible pivoting feature the summarized data can be easily reoriented to allow comparisons of multiple dimensions of data.

Demo 4:

Goal: To produce a pivot style report which provides counts of current tenured and tenure-track appointees divided by category status and ordered by department and by college in the Academic Affairs Division.

This query will retrieve information on tenured and tenure-track appointees that will allow the summarization of data and presentation in a pivot report.

Your final report should look like the following: [Pay special attention to the format and not the data specifically as changes may occur due to the dynamic nature of current, active appointments.]
Creating a Query and Subsequent Pivot Report

- Open a New document and log on (use auto logon feature if still connected to the database).
- Expand the Tables folder (click on the +) in the Catalog Pane.
- Move ARS_Current_Appts topic to the workspace.
- Add data items: Coll Unit, Hr Dept, Category Status, Title Rank, Name and U Id to the Request Line.
- Place a limit on Ten Tentrk Faculty data item setting it to = Y.
- Process the query.
- Review results, but it is not necessary to format the results report.

To begin creating a Pivot report, the Pivot section needs to be inserted into the BrioQuery document.

- Click on Insert from the menubar, click New Pivot. Notice the Pivot section is added to the Section catalog on the left.

- If the Outliner is not displayed in the blank pivot report, click the Outliner button to display it.

The Outliner in The Pivot Section
- The Outliner in the Pivot section consists of three different sections:
  - data items in the Top Labels section create column headings.
  - data items in the Side Labels section create row headings.
  - data items in the Facts section are the numeric values that are broken up in the body of the Pivot Report.
**Populating the Outliner**

In BrioQuery, the user can build a Pivot Report by dragging one or more items from the Request Line to various panels in the Outliner window. The top and side panels correspond to the top and side labels of the report. The bottom right panel holds the report values.

- Drag **Coll Unit** and **Hr Dept** (in this order) into the **Side Labels** panel.
- Drag **Category Status** into the **Top Labels** panel.
- Drag **U Id** into the **Data Values** panel.

The Outliner, once populated should look like this:

![Outliner Window]

In order to reflect meaningful values in the Pivot Report, the **U Id** data item’s data function must be changed to a count:

- Select the data values by clicking anywhere in the **U Id** column.
- Select Pivot menu, select Data Function and select Count.
- Select the column, right-click, select Data Function and select Count.

Notice that the suppressing of duplicates is automatic in the Pivot Report. Proceed with formatting the Pivot Report.
- Resize columns. Select column by clicking on the line in the top margin of the column.

**Adding Subtotals and Totals to the Report**

In the Pivot section, subtotals and totals can be created to further summarize the reporting of data.

To consolidate the counts by department, create totals using the **Category Status** top label.

- Select the tab/handle on right of the **Category Status** top label.
- Select Pivot menu and select Add Totals.
- Select tab, right-click and select Add Totals.
- Select tab, click \(\sum\) on the Standard toolbar.

To provide counts by college, create totals using the **Hr Dept** side label.

- Select the tab/handle on the bottom of the **Hr Dept** side label.
- Select Pivot menu and select Add Totals.
- Select tab, right-click and select Add Totals.
- Select tab, click \(\sum\) on the Standard toolbar.
Drilling Down in the Pivot Report

Drill-down is a powerful feature that instantly provides detailed analysis for selected data items.

- Select **Hr Dept** column by clicking on the line in the top margin of the column.
- Select **Pivot** menu, select **Drilldown Anywhere** and select **Title Rank**.
- Select column, right-click, select **Drilldown Anywhere** and select **Title Rank**.
- Click on **Pivot** in the menubar, select **Drill Anywhere**, select **Title Rank**.

The user can drilldown into the most detailed data items based on the data items that were requested in the query. To **remove** the drilled down data items from the **Pivot**:

- Select the **Title Rank** column.
- Select **Pivot** menu, select **Drillup**.

**Spotlighter**

In the **Pivot Report** it is possible to identify key data by making it standout:

- Highlight the area you want to spotlight (Side Labels, Top Labels or Facts).
- Select **Format** menu, select **Spotlighter**.
- The Spotlighter dialog box will appear.
- Change the **Operator** to the desired command.
- In the **Value** window, type in the appropriate value.
- Click on the **Syles** you desire (font, background, bold, underline, italics).
- Click the green checkmark, then click anywhere on the workspace.

**Corner Labels**

You may wish to identify your Top and Side Labels in your report:

- Somewhere on your workspace, right click your mouse.
- Select **Corner Labels**.
- Select, Top, Side or Both depending on which labels you would like to identify.
- To remove the Corner Labels, repeat the steps above but choose None.
You have now achieved the goal set forth at the beginning of this demo 4.

Print Preview Mode

Before printing a report, it is possible to preview the printed report. The Print Preview option allows the viewing of the report exactly as it will be printed. Headers and footers can be added, page scrolling is enabled and margins can be formatted in Print Preview mode.

Adding a Header or Footer to a Report

Custom headers and footers, including page numbers and dates, can be added to BrioQuery reports prior to printing. Headers and footers can be added to the active section tab of the BrioQuery document in either regular or Print Preview mode. However, the headers and footers are only viewable in Print Preview mode. For this reason, our instructions will be from the print preview perspective. If the user prefers to add headers and footers from the regular mode, select Insert menu and select Page Header or Page Footer.
To add a **Page Header** and a **Page Footer** to the **Pivot Report** just created in Demo 4

⇒ Switch to **Print Preview** mode by selecting the **File** menu and selecting **Print Preview**.

⇒ Press on the Standard toolbar.
⇒ Right-click on the report to access the speed menu and select **Page Header**.
⇒ Click on **Insert** from the menubar and select **Page Header**.

An **Edit Header** dialog box will appear.

⇒ Type **Current Tenured & Tenure-Track Faculty Counts** and press ENTER to move to the next line.

⇒ Type **as of** and a **space** and press the button at the bottom of the dialog box to display the date.

A date code will appear to the right of the **as of** text in the dialog box.

⇒ Click **OK**

View the header. To format the header, click within the header area and use features on the **Format** menu or the **Format** toolbar to change the **Font**, **Font Size**, **Font Style** or **Justification**.

If distinct formatting is desired between the two header lines, two headers should be created with each one containing a line of text.
To add a **Page Footer** to the **Pivot Report**:  
- Right-click and select **Page Footer**.
- Type in **Page** and a space and press the button at the bottom of the dialog box to display the page number.
- Type of and a space and press the button at the bottom of the dialog box to display the total number of pages in the report.

- Click on **OK**.

**Editing Page Headers and Footers**  
To edit a header/footer, the user must be in **Print Preview** mode. Double-click on a header/footer and the **Edit Header/Footer** dialog box will appear allowing the user to make modifications.

**Scrolling in Print Preview Mode**  
To view other pages in **Print Preview** model, the **Page Up** and **Page Down** keys on the keyboard can be used. Alternatively, there are options in the **Print Preview** menu to view **First Page**, **Previous Page**, **Next Page** and **Last Page**. The scroll bar on the right side of the workspace allows scrolling within each page.

**Adjusting the Margins**  
The faint, dotted lines in your report in Print Preview mode represent the margin lines. These margins can be manually adjusted by passing the cursor over the line and clicking once it becomes a bi-directional arrow and then dragging the line to the desired location.
**Exiting Print Preview Mode**

To return to regular mode:

- Select **File** menu and toggle off **PrintPreview**.
- Press 📹 on the Standard toolbar.

**Printing**

Reports can be printed using the **Print** command on the **File** menu. If it is necessary to change the report’s orientation to landscape mode, select **File** menu, select **Page Setup** and select the **Landscape** radio button and click on **OK**.

**[DO NOT PRINT DEMO PIVOT REPORT IN LAB]**

- Select **File** menu and select **Print**.
- Click on the Print icon 📹 in the standard toolbar.
Exercise 2: Count of Current Appointments

Goal: To prepare a query and pivot report that details the counts of current tenured and tenure-track appointees in the College of Behavioral and Social Sciences by department and divided by Title Rank. Display totals by department and for the college.

This query should return information on columns Coll Unit, Hr Dept, Title Rank and U Id.

It should be filtered in the Query section to return data only for those who are tenured or tenure-track (Ten Tentrk Faculty is a Yes/No field) within the College of Behavioral and Social Sciences (Coll Unit Cd = 128).

The data function of the U Id data item will need to be modified to represent a “count” in the Pivot Report.

The final report should look like this:
[Compare to the following graphic for format only and not the data specifically as changes may occur due to the dynamic nature of current, active appointments.]
**Preparation**
1. Select **File** menu and select **New**.
2. Accept the **Auto Logon** prompt and Brio will automatically log you on using the same OCE and display the **Tables** in the Catalog Pane.
3. Move the **ARS_Current_Appts** topic onto the workspace.

**Detailed Exercise Steps**
Try performing the exercise on your own, but if you get stuck, the following steps will help you complete this exercise:

1. Add the items: **Coll Unit**, **Hr Dept**, **Title Rank** and **U Id** to the **Request Line**.

2. Toggle on the **Limit Line** in the **Query** section by clicking on the Limit button **Limits** above the **Request Line**.

3. Limit the query (in the **Query** section) by setting **Coll Unit Cd** = 128 and **Ten Tentrk Faculty** = Y.

4. Process the query and review the data returned.

5. Insert a **New Pivot** report.

6. Click on the **Outliner** button **Outliner** if the outliner is not displayed at the bottom of the pivot window.

7. Populate the **Outliner** with:
   - Top label: **Title Rank**
   - Side labels: **Coll Unit**, **Hr Dept**
   - Facts: **U Id**

8. Modify the data function of the **U Id** data values to represent a **count**.

9. Add totals using the handle of the **Title Rank** column heading.

10. Add totals using the handle of the **Hr Dept** row heading.

11. Resize columns if necessary.

12. Compare your Pivot Report to the graphic on the previous page.

[DO NOT CLOSE THIS QUERY, WE WILL WORK WITH THIS SAME QUERY IN DEMO 5]
Summary

In this chapter you have learned the basics of refining queries and creating pivot reports. The following is a review of the important points:

- **Pivot Reports** can easily be created to summarize the results data set.

- In the **Pivot** section the **Outliner** is populated using three sections to create: top labels, side labels and data values.

- Data values can be modified in the **Pivot** section and a data function can be applied.

- Totals can be added in the **Pivot Report** to summarize the data in the report.

- **Drill-down** is a powerful feature of the **Pivot Report** enabling the user to examine the detail behind the summarized data.

- “Pivoting” column and row headings in the **Pivot Report** enables the user to change the presentation and focus of the report quickly and easily.

- **Print Preview** mode is used to add headers, add footers, adjust margins and preview the report prior to printing.

- Printing is enabled through the use of the **File** menu.
Part 4:

Report Designer

In this chapter you will learn how to:

- Create a basic report using the Report Designer.
- Modify the data function of a table fact column.
- Change the formatting in a Report.
- Hide, display and rearrange subtotals & totals.
- Add page breaks and repeat report group header titles.
Demonstration 5

We will use one demonstration to discuss creating reports. In this demo you will learn how to create a simple report using the Groups and Table outliners.

Report Designer

Reports are a dynamic view of your data in which data can be grouped and sorted for printed reports and presentations. The Report Designer provides the user with an almost unlimited framework for presenting results data, including the automatic summing of numeric data and does not have a print-preview mode since the page view of the report represents exactly what will be printed.

Demo 5:

Goal: To produce a report listing the current tenured and tenure-track faculty appointees in the College of Behavioral and Social Sciences ordered by department and title rank within department, including appointment titles and category status and providing counts by title rank, by department and for the college.

This query will retrieve information on tenured and tenure-track appointees that will allow for the detailed presentation described above.

Your final report will look like the following:

[Pay special attention to the format and not the data specifically as changes may occur due to the dynamic nature of current, active appointments.]

Current BSOS Appointments

<table>
<thead>
<tr>
<th>BSOS</th>
<th>College Total-216</th>
</tr>
</thead>
<tbody>
<tr>
<td>Afro-American Studies Prog</td>
<td>Department Total-0</td>
</tr>
</tbody>
</table>

**Assist Prof**

<table>
<thead>
<tr>
<th>Name</th>
<th>Dept Title</th>
<th>Category Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Namendel, Joshua 6.</td>
<td>Assistant Professor</td>
<td>FACULTY TENURED, ON TRACK</td>
</tr>
<tr>
<td>Wood, Clyde A.</td>
<td>Assistant Professor</td>
<td>FACULTY TENURED, ON TRACK</td>
</tr>
</tbody>
</table>

**Assoc Prof**

<table>
<thead>
<tr>
<th>Name</th>
<th>Dept Title</th>
<th>Category Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Wilson, Franklin R.</td>
<td>Associate Professor</td>
<td>FACULTY TENURED</td>
</tr>
<tr>
<td>Wilson, James J.</td>
<td>Associate Professor</td>
<td>FACULTY TENURED</td>
</tr>
<tr>
<td>Harley, Sharon</td>
<td>Associate Professor</td>
<td>FACULTY TENURED</td>
</tr>
</tbody>
</table>

**Professor**

<table>
<thead>
<tr>
<th>Name</th>
<th>Dept Title</th>
<th>Category Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Donah, Franklin</td>
<td>Professor</td>
<td>FACULTY TENURED</td>
</tr>
</tbody>
</table>
Modifying our Query and Creating a Report

⇒ Return to the Query section by selecting the Query from the Section Pane (or by clicking on the Section Name if the Section/Catalog Pane is hidden).
⇒ Add items: Name, Appt Title and Category Status to the Request Line.
⇒ Process the query.
⇒ Review the results, but it is not necessary to format the results report.

To begin creating a report,
⇒ Click on Insert from the menubar, then select New Report.
⇒ If the Report Group or Table Dimensions/Facts outliners are not displayed at the bottom of the report’s workspace, click on the Groups or Table buttons located above the Report workspace to display them.

The Group and Table outliners in the Report Section

The outliners in the Reports section allows you to organize the information and results of your query using the following three sections:
- Data items in the Report Groups section define the overall groupings of data in the report.
- Data items in the Table Dimensions section identify the secondary headings that make up the body of the report.
- Data items in the Table Facts section represent the measurable data that make up the body of the report.

Displaying the sections of the Report

The sections will help you put your report together, you will see the section outlines on the screen but they will not appear when you print the report.
- Select Report from the menubar, click Section Boundaries.
- Select Report from the menubar, click Headers and Footers, then click Show Both under Report Header and Report Footer.
- Select Report from the menubar, click Headers and Footers, then click Show Both under Page Header and Page Footer.

Populating the Groups and Table Outliners

In BrioQuery, the user can build a custom Report by dragging column names from the Results Columns displayed in the Catalog Pane to various panels in the either the Groups or Tables Outliners.
⇒ Drag Coll Unit into the Report Group1 category panel. Each time a Report
Group has a data item in it, it will create another Report Group to use. Drag Hr Dept into Report Group2 and drag Title Rank into the Report Group3 category panel.

Drag Name, Appt Title and Category Status (in this order) into the Table Dimensions panel.

The Outliner, once populated should look like this:

![Image of Outliner]

**Sorting Columns**

Data in columns from Report Groups and Tables can be sorted on a Report.

To Sort a Report Group Header

- Click on the name of the Department in the workspace. A parameter box will appear around the department.
- Click on the Ascending or Descending buttons in the Format Toolbar to sort.
- Click on data in Table Column or Report Group and notice the Sort Line contains the column name.
- Repeat this process with the Title Rank.

To Sort columns of data

- In the workspace click on data in a Table Column
- Click on the Ascending or Descending buttons in the Format Toolbar to sort.
- Click on any sorted data column and notice the Sort Line contains the column names.

To Delete a Sort

- Click on Table Column or Report Group, this will display which columns are on the Sort Line
- Click on column name in Sort Line to be deleted
- Press the Delete key on the keyboard or click on the Remove button in the Standard Toolbar.
**Resizing**

Both Report Group Headers and Table Dimensions Facts and Columns can be resized.

- Click on the department name in the workspace. A parameter box will appear around it.
- Move the cursor to the center box on the right margin. When the double headed arrow appears, double-click OR manually resize the column by clicking and dragging the mouse until the you’ve reached the desired width.

**Columns in a Table in the Body section can be resized**

- Click on the column to select it
- Move the cursor to the right margin of the column. When the double headed arrow appears, double-click OR manually resize the column by clicking and dragging the mouse until the column is wide enough.

**Changing Color of Column Headers**

The Column headers can be changed from the default blue to transparent to improve the quality of your printing.

- Click on a column header. The highlighting will change to black.
- Click the down arrow next to the capital A on the format toolbar, this will display the color pallet.
  - Click on the black square in the top left corner. This will change the text to black.
  - Click the column header again.
  - Click the down arrow on the paint bucket on the format toolbar, this will display the color pallet.
  - Click to the Transparent bar at the top of the pallet. This will clear the background of color.
  - You can change multiple columns at once by clicking on the first column header. Hold down the Shift button and click on the far right column. All columns will be highlighted, perform desired change.
  - Column headers can also have all formatting changed, justification, bold, font size, font style, bold, italics and underlines

**Totals and Subtotals**

In BrioQuery, the user can drag U Id from the Catalog Pane and by dropping it in the proper header or footer to get totals and subtotals.

- Select U Id in the Results section of the Catalog Pane.
- Click and drag U Id to the Report Group1 Header section and drop it directly onto the report. Click on the U Ids so that the parameter box appears around them. The U Ids will need to be changed to a count. Click on Report from the
menubar, (or right click the mouse) select **Data Function** and select **Count**.

- Repeat this procedure for **Hr Dept**, but drag and drop the **U Id** column into **Report Group2 Header** and then change the **U Id** to a **Count**.
- Repeat again with **Title Rank**.

**Displaying Subtotals and Totals**

You can enhance your totals and subtotals and give them more meaning.

- Click on the Total in the **Report Group Header 1**. A parameter box will appear around the number.
- Click the **Expression** button located above the Report workspace.
- Put the cursor in front of the word **Tables**.
- Type in, “College Total=”+
- Click the green check mark.
- You can now change font size, style format etc.
- Repeat these steps with **HR Dept** and **Title Rank**.

**Rearranging Subtotals and Totals**

The totals and subtotals can be aligned either left, right, center, top, middle, bottom and the height and width of the columns can be made the same.

- Select the first **U Id** count in the **Report Group1 Header** section. While holding down the Ctrl key on the keyboard, select the other **U Id** count fields from **Report Group2** and **Report Group3** sections.
- Click on the **Alignment** button in the **Section Toolbar**. If the Section Toolbar is not displayed, turn it on by clicking on **View** in the menubar, click **Toolbars**, then click **Section**. Click **Left** to align the fields to the left. This will align all of the fields to the one that is farthest to the left.

**Clear Highlighting**

To clear the highlighting in the report, click on any blank space in the report.
Resize the category headings Hr Dept and Title Rank by selecting the category heading. Select the first Hr Dept in the report and parameters around it will appear. Move the mouse until the double-headed arrows appear, then click and drag to expand the width of the text box to the right in case any characters are truncated. All of the Hr Dept category headings will then be highlighted and resized.

Removing Grid Lines and Borders of a Table
By default, Brio places Grid Lines and Borders in the table within the body section of the report. Unfortunately, this is not a default option—it must be performed in every report inserted, if desired.

To Remove Table Grid Lines
⇒ Click once on the Table to highlight it
⇒ Select Format from the menubar, Grid Lines…
⇒ Select None in the Properties menu for Horizontal or Vertical grid lines
⇒ Click OK when finished.

To Remove Table Borders or Customize the Table Background
⇒ Click once on the Table to highlight it
⇒ Select Format from the menubar, Border and Background…
⇒ Select None in the Properties window for Border and select Custom if a Background color is desired for the Table, then select a color of your liking.
⇒ Click OK when finished.

Adding a Page Header or Footer to a Report
FYI Adding Page Headers and Footers to Reports are done differently than adding them in Pivot Reports. To turn on the section boundaries for Page Header and Page Footer in Reports,
⇒ Select Report from the menubar, click Headers and Footers, then click Show Both under Page Header and Page Footer.

Notice that the Page Number is already placed in the Page Header for your convenience.

From the Catalog Pane on the left, notice the Graphics folder and the Fields folder.
⇒ Click on the ‡ next to the Graphics folder to expand it. The Graphics folder contains tools that may be used in a report.
⇒ Click on the ‡ next to the Fields folder to expand it. The Fields folder also contains tools that may be used in a report.
⇒ Click and drag the An Text Label tool from the Graphics folder into the Page Header section of the Report
⇒ Click directly on the text, "Text Label” in the Page Header to select it.
Click again directly on the text to highlight the text and display the text box. This is called, "text edit mode". Type in the text, "Current BSOS Appointments". To save the text, click outside of the text label's parameters. Repeat this process if a Page Footer is desired using Graphics or Fields from the Catalog Pane.

Moving a Text Label in the Page Header or Footer
If the Text Label is not in a position in the header where it needs to be, it can be moved by clicking and dragging the Text Label to a new position within the Page Header. Example:

Before moving the Text Label

After the Text Label has been moved

Scroll down in the Report to the Page Footer area. Notice that the Page Number is already placed in the Page Footer for your convenience. The Page Number can be moved around within the Page Footer section much like the Text Label was repositioned in the Page Header section.

Page Breaks
If it is necessary to break the pages in a report by Report Group headings, the user can control page breaks using the Insert menu.

To place page breaks after each department included in the report:
Display the header and footers for the Report Groups. Right-click on Hr Dept in Report Group2 and select Show Both from the speed menu.

On the report you will see the Report Group2 Footer under the Body section.

Click once in the Report Group2 Footer to select it, then right-click and select Page Break After
The report will now be displayed with one department on each page.

- Repeating Report Group Header Titles

FYI In lengthy reports the Report Group Headers will not continue onto more than one page without the user specifying that it should repeat these group header titles to provide descriptive information. If the Report will have groupings (categories) of data flowing onto more than one page, a Report feature Repeat Header can be toggled on.

- Click on the report in the Report Group Header that you wish to repeat. Right-click and select Repeat Header from the speed menu.
Deleting a Text Label in the Page Header or Footer

*If a Text Label is not desired, it can be deleted.*

- Click on the **Page Number Text Label** in the **Page Header**.
- Make sure the text label is highlighted with the parameters around it. It may need to be moved slightly so that it is not in text edit mode.
- Press the **Delete** button on the keyboard.
- Select **Edit** from the menubar, then click **Cut**

---

**Current BSOS Appointments**

<table>
<thead>
<tr>
<th>BSOS</th>
<th>Afro-American Studies Prog</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Assist Prof</strong></td>
<td>College Total: 216</td>
</tr>
<tr>
<td>Name</td>
<td>Dept. Title</td>
</tr>
<tr>
<td>Namehead, John</td>
<td>Assistant Professor</td>
</tr>
<tr>
<td>weed, Kyle A.</td>
<td>Assistant Professor</td>
</tr>
<tr>
<td><strong>Assoc Prof</strong></td>
<td>Department Total: 6</td>
</tr>
<tr>
<td>Name</td>
<td>Dept. Title</td>
</tr>
<tr>
<td>Wilson, Francine R.</td>
<td>Associate Professor</td>
</tr>
<tr>
<td>Wilson, Jlavell</td>
<td>Associate Professor</td>
</tr>
<tr>
<td>Harvey, Sharon</td>
<td>Associate Professor</td>
</tr>
<tr>
<td><strong>Professor</strong></td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td>Dept. Title</td>
</tr>
<tr>
<td>Dukes, Patrick</td>
<td>Professor</td>
</tr>
</tbody>
</table>

---

You have now achieved the goal set forth at the beginning of this demo.
Summary

In this chapter you have learned the basics of creating reports. The following is a review of the important points:

- In **Reports** the **Outliner** is populated using three sections to create: **report groups**, **table dimensions** in the body and **table facts** in the body.

- A table fact in the **Report** can be modified using the **Report** menu and selecting **Data Function**.

- Totals for **Report Groups** can be used by clicking and dragging **table facts** from the **Category Pane** into the **Report Group Header**.

- All elements of the **Report** can be formatted.

- Page breaks can be used when distributing a report to many recipients using the **Insert** menu selecting **Page Break Before** or **Page Break After**

- **Report Group Headers** can be repeated onto more than one page.

- **Page Headers** and **Page Footers** can be created and customized.
Part 5:

Preparation for Using BrioQuery at Your Desktop

In this chapter you will learn how to:

- Select an OCE to be the default.
- Enable the Auto Logon feature.
- Set preferences & defaults at your desktop.
- Change your database password.
- Access data definitions on the web.
- Access Data Administration’s Data Warehouse web page.
Setting an OCE to be the Default

A default OCE can be a timesaver for individuals primarily accessing the same database server. To set an OCE to be the default for your workstation:

⇒ Select **Tools** from the menubar, select **Options** click **Program Options**.
⇒ Select **File Locations** tab.

![BrioQuery Options](image)

⇒ Select the **Browse** button next to the **Default Connection** entry line.
⇒ Select your preferred OCE from the **Select Open Catalog** dialog box.
⇒ Click on **Open** to return to the **BrioQuery Options** dialog box.
⇒ Click on **OK**.

Connecting to Multiple Database Servers

For individuals accessing several database servers, it is easier to select an OCE upon connecting to the database server. If this is the case, it is best **not** to have a default OCE. To clear a default OCE selection:

⇒ Select **Tools** menu, select **Options** and select **Program Options**.
⇒ Select **File Locations** tab.
⇒ Clear any entry in the **Default Connection** entry line.
⇒ Click on **OK**.

To select an OCE upon connection:
⇒ If no connection window appears, in a new document, select **Tools** menu, select **Connection**, click **Select**
Enabling Auto Logon Feature

For individuals connecting with a default OCE, it is also extremely helpful to have the Auto Logon feature activated. We have used this feature in class to save the time of logging into the database a second and third time when creating multiple queries against the same database. To enable Auto Logon:

- Select Tools menu, select Options and select Program Options.
- Select General tab.
- Click box next to Auto Logon to place a checkmark.
- Click on OK.

If you access multiple databases, this feature may not be useful. If you prefer to have Auto Logon disabled, follow the same instructions as above, but remove the checkmark by clicking on it.
Setting Default Formats at Your Desktop

It is possible to customize the default format of your BrioQuery document. You can do this for most aspects of the BrioQuery document. To change the default formats:

⇒ Select Tools menu, select Options and select Default Formats.

A Default Fonts and Styles dialog box will appear:

⇒ Select any of the five tabs named for each section of the BrioQuery document: Query, Table, Pivot, Report, and Chart to set defaults in each section. Note: OLAP section is not mentioned because the UM Data Warehouse does not store data in OLAP cubes.

⇒ Select the Numbers tab to set default formats of dates, timestamps, and numbers that appear in your BrioQuery document.

Changing Your Data Warehouse Password

Comprehensive information on how to change your Data Warehouse is available on our website at:

http://www.oit.umd.edu/units/dataadmin/DataWarehouse/Passwords/
Accessing Data Definitions on the Web

All data items included in the Data Warehouse are supported by documentation. This documentation defines, in detail, the data item. It is possible to view the brief data definition using the Remarks feature within BrioQuery. However, it is possible to view the brief and supplementary (detailed) data definitions using a simple search mechanism on the Data Administration web site. To access the data definitions on the web, go to the following URL using your web browser:

http://www.oit.umd.edu/dataadmin/DataDef/

From this page you can select Search for Data Definitions.

Accessing Data Warehouse Information on the Web

We have a Data Warehouse web site that includes general information, data subset information, user group information, functions & features as well as information related to getting started (applying for account, purchasing software, loading patches, etc.) To access information on the web pertaining to the Data Warehouse, go to the following URL using your web browser:

http://www.oit.umd.edu/dataadmin/DataWarehouse
Appendix

- Setting Remarks & Enhancing Show Values on the Desktop.
- Finding and Loading Patches to BrioQuery Enterprise Explorer.
- Data Warehouse User Groups.
- Accessing Data Definitions on the Web.
- Parts of the Query Section.
- Parts of the Results Section.
- Parts of the Report Section.
- Parts of the Pivot Section.
Setting Remarks & Enhancing Show Values on the Desktop

1. Open a blank BrioQuery document (not logged on).

2. Select Tools from the menubar, Connection, Create.

3. In the Database Connection Wizard dialog box, select the drop-down box for the question, “What connection software do you want to use?” and select SQL*Net for Windows NT.


5. Click the box next to Show Meta Connection Wizard to select it, then click Next.

6. Enter in your username and password in the appropriate fields. Enter in ACCPRD1 for the Host: field, then click Next.

7. Make sure “On the current connection” is selected, then click Next.

8. Click the Edit button to edit the Custom… Meta Connection Wizard.

9. Select the Lookup tab, then select Use SQL Definition. This will allow editing of the fields.

10. Enter in text exactly as shown below, click on the Remarks tab when finished.

11. Select Remarks.

12. Enter text for the Definition table remarks exactly as shown below. Click on Add.
13. Enter text for the Example table remarks exactly as shown below. Click on Add when finished.

14. Select Column Remarks
15. Enter text for the Definition column remarks exactly as shown below. Click on Add when finished.

16. Enter text for the Example column remarks exactly as shown below. Click on Add when finished.

17. Click OK.

18. Click Next.

19. Click Finish.

20. Click Yes in the BrioQuery box alerting you to save your changes.

21. Type in the name you wish to give this OCE file.

22. Click Save.
Data Warehouse User Groups

Access the Data Administration web site for Data Warehouse users to find out more about the Data Warehouse User Group and Advanced User Group. User Group Meetings are conducted by the Office of Data Administration and Data Managers to foster use of the Data Warehouse, demonstrate new features and tips & tricks as well as encourage networking between the Data Warehouse users. Go to the following URL using your web browser:

http://www.oit.umd.edu/dataadmin/DataWarehouse/Dwusergroup/

Accessing Data Definitions on the Web

All data items included in the Data Warehouse are supported by documentation. This documentation defines, in detail, the data item. It is possible to view the brief data definition using the **Show Remarks** feature within BrioQuery. However, it is possible to view the brief and supplementary (detailed) data definitions using a simple search mechanism on the Data Administration web site. To access the data definitions on the web, go to the following URL using your web browser:

http://www.oit.umd.edu/dataadmin/DataDef/
Parts of the Query Section in a BrioQuery 6 Document

Legend:
1. Remove
2. Format Painter
3. Show Section/Catalog
4. Insert Section
5. Properties
6. Limit
7. Sort Ascending
8. Sort Descending
9. Grand Total
10. Group Items
11. Process
12. Connections
13. Back
14. Forward
15. ES Home
16. Help
17. Section Title Bar
18. Request button
19. Limits button
20. Sort button
21. Back arrow
22. Forward arrow
23. Catalog pane
24. Tables
25. Request line
26. Sort line
27. Limit line
28. Topic Items
29. Topic
30. Content pane
31. Status bar
32. Section pane
Parts of the Results Section in a BrioQuery 6 Document

Legend:
1. Select All corner
2. Column heading
3. Limit line
4. Sort line
5. Row heading
6. Section pane
7. Catalog pane
8, 9. Request columns
10. Cell
11. Row
12. Column title
Parts of the Pivot Section in a BrioQuery 6 Document

Legend:
1. Sort line
2. Sort Item
3. Top Labels
4. Sort type
5. Outliner button
6. Outliner
7. Side Labels pane in Outliner
8. Side Labels
9. Top Labels pane in Outliner
10. Facts Labels pane in Outliner
11. Dimension tab
12. Data Labels
13. Facts
14. Content pane
15. Catalog pane
16. Request columns
17. Sort Aggregate
Parts of the Report Section in a BrioQuery 6 Document

Report Section

1. File
2. Edit
3. View
4. Insert
5. Format
6. Report
7. Tools
8. Window
9. Help
10. Zoom
11. Sort
12. Expression
13. Groups
14. Table
15. Sort Expression
16. Sections
17. Report
18. Results
19. Pivot
20. Item Type by Year
21. Line
22. Hit Line
23. Vi Line
24. Report Group
25. Report Grouped
26. Table Dimensions
27. Table Facts: Amount + Units

Report Group:
- Drag columns here &
- Drag columns here &

Yr & Qtr for Item Types & Names

Table Dimensions:
- Items, Table
- Items, Table

Table Facts: Amount + Units
Legend:

<table>
<thead>
<tr>
<th></th>
<th>Description</th>
<th></th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Groups button</td>
<td>14</td>
<td>Sort line</td>
</tr>
<tr>
<td>2</td>
<td>Table button</td>
<td>15</td>
<td>Expression line</td>
</tr>
<tr>
<td>3</td>
<td>Sort button</td>
<td>16</td>
<td>Graphic items</td>
</tr>
<tr>
<td>4</td>
<td>Expression button</td>
<td>17</td>
<td>Report fields</td>
</tr>
<tr>
<td>5</td>
<td>Catalog pane</td>
<td>18</td>
<td>Columns</td>
</tr>
<tr>
<td>6</td>
<td>Results columns</td>
<td>19</td>
<td>Embedded pivot</td>
</tr>
<tr>
<td>7</td>
<td>Sections</td>
<td>20</td>
<td>Embedded chart</td>
</tr>
<tr>
<td>8</td>
<td>Content pane</td>
<td>21</td>
<td>Groups Outliner</td>
</tr>
<tr>
<td>9</td>
<td>Alignment</td>
<td>22</td>
<td>Dimensions pane of Table Outliner</td>
</tr>
<tr>
<td>10</td>
<td>Resizing</td>
<td>23</td>
<td>Facts pane of Table Outliner</td>
</tr>
<tr>
<td>11</td>
<td>Layers</td>
<td>24</td>
<td>Table Outliner</td>
</tr>
<tr>
<td>12</td>
<td>Set Spring</td>
<td></td>
<td></td>
</tr>
<tr>
<td>13</td>
<td>Zoom</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>